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Chapter 1: Getting started

Computer requirements 2
Activation connectivity 2

Using SMART Install Manager 3
Using Activation Wizard 3

This guide explains how to customize and deploy the following software:

l SMART Notebook 17.1 collaborative learning software

l SMART Product Drivers 12.9

l SMART Ink® 5.2

l Handwriting recognition

l SMART Common Files

IMPORTANT

If SMART Response is currently installed, updating to Notebook 17 will replace SMART Response

with the new SMART response 2 assessment tool. Please review the details to ensure it will not

disrupt current teacher work flows. Existing assessment data may need to be backed up. For

more information see the SMART response 2 FAQs .

NOTE

For information on customizing and deploying previous versions of this software, see the

appropriate system administrator’s guides at smarttech.com/support.

This guide is intended for IT administrators and others experienced with customizing, deploying

and administering software on Mac computers in a networked environment. To use this guide, you

must:

l Know how to complete basic administrative tasks in OS X operating system software such as

working in Terminal

http://www.smarttech.com/kb/171151
https://education.smarttech.com/en/products/smart-learning-suite/smart-response-2/smart-response-2-faqs
http://www.smarttech.com/support


CHAPTER 1
GETTING STARTED

2 smarttech.com/kb/171151

l Have administrative privileges and access to servers

l Have access to the Internet

Computer requirements

NOTE

Operating systems and other third-party software released after this SMART software might not

be supported.

Before you install the software, ensure your teachers’ computers meet the minimum requirements:

Supported
operating systems

macOS Sierra (10.12)

OS X El Capitan (10.11)

OS X Yosemite (10.10)

Minimum processor Intel® Core™ 2 Duo

Minimum RAM 2 GB (4 GB for UHD displays)

Minimum hard disk
space

2.3 GB

Other requirements Safari application program 8 or later

Internet access to download SMART software

IMPORTANT

Some features require access to specific websites. You might need to white list those websites

if you restrict outbound Internet access.

See SMART knowledge base article SMART Notebook add-ons behave unexpectedly behind a

firewall or proxy for a complete list of websites to white list.

Activation connectivity
When you deploy SMART Notebook software, make sure the computers can access SMART’s web

activation services. Otherwise, the computers will not be able to activate product keys, during or

after installation.

http://www.smarttech.com/kb/171151
https://community.smarttech.com/s/article/ka40P000000CrLDQA0/SMART-Notebook-including-SMART-lab-and-response-add-ons-behave-unexpectedly-behind-a-firewall-or-proxy?language=en_US
https://community.smarttech.com/s/article/ka40P000000CrLDQA0/SMART-Notebook-including-SMART-lab-and-response-add-ons-behave-unexpectedly-behind-a-firewall-or-proxy?language=en_US
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The activation web services are accessible at the following URLs:

l https://activationservice.smarttech.com/IntegrationCore?WSDL

l https://activationservice.smarttech.com/flexnet/services/ActivationService?WSDL

l https://webservices.smarttech.com/products/Activation_advanced.asmx?WSDL

l https://entitlement.smarttech-prod.com/reachability

When viewed in a web browser, the first three URLs above should display a WSDL document. The

last URL should display a XML document: <?xml version="1.0"?><reachable/>.

NOTE

If these sites are blocked by a proxy in your organization, add the URLs to the proxies.

SMART Install Manager and Activation Wizard will test these URLs and indicate success or failure.

When you use the SMART Install Manager tool, consider that you, as an administrator, may have

less restricted access to the Internet than standard users. It is important to install SMART Notebook

software on a standard user’s computer and use the Activation Wizard connectivity tester to

confirm connectivity.

Using SMART Install Manager
Start the connectivity tester by pressing the Check Activation Server button. The tester will appear

and show green check marks to indicate success. SMART Install Manager will also prompt you to

use the connectivity tester at the time of publishing customizations.

Using Activation Wizard
In the Activation Wizard you can access the connectivity tester from the Advanced drop-down

menu in the lower left of the Activation Wizard. The tester will appear and show green check marks

to indicate success.

http://www.smarttech.com/kb/171151
https://activationservice.smarttech.com/IntegrationCore?WSDL
https://activationservice.smarttech.com/flexnet/services/ActivationService?WSDL
https://webservices.smarttech.com/products/Activation_advanced.asmx?WSDL
https://entitlement.smarttech-prod.com/reachability
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Chapter 2: Customizing the software

Using SMART Install Manager 5
SMART Install Manager controls 6

Updating SMART Learning Suite 17.1 8
Removing SMART Install Manager 9

You can use SMART Install Manager to customize the software.

Using SMART Install Manager
Using SMART Install Manager, you can customize SMART software installation packages by

publishing PKG files. You can then deploy the SMART software to computers.

To download and install SMART Install Manager

1. Go to education.smarttech.com/en/products/notebook/download#admin.

2. Select SMART Notebook 17.1 from Select your version.

3. Press SMART Install Manager, and then save the installer file to your computer.

4. Enter your information in the following fields:

a. First Name

b. Last Name

c. Job Title

d. Email

e. Country

5. Select the service terms check box.

6. Click DOWNLOAD - MAC.

7. Double-click the installer file.

The SMART Install Manager installation wizard appears.
8. Follow the instructions.

http://www.smarttech.com/kb/171151
https://education.smarttech.com/en/products/notebook/download#admin
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To customize SMART Learning Suite 17.1 using SMART Install Manager

1. Start SMART Install Manager.

2. Drag the installation package to the SMART Install Manager window.

3. Set the controls on each page (see SMART Install Manager controls below).

4. Select File > Publish.

A dialog box appears.

5. Browse to the location where you extracted the complete installer or the installation package.

6. Type a name for the PKG file, and then press Save.

7. Close SMART Install Manager.

SMART Install Manager controls

Control Procedure Notes

General Options: Product Selection

SMART Product Drivers Select to install SMART Product Drivers. [N/A]

SMART Ink Select to install SMART Ink. If you install SMART Ink, you must install SMART
Product Drivers.When you select this checkbox,
SMART InstallManager selects SMART Product
Drivers automatically.

SMART Notebook
software

Select to install SMART Notebooksoftware. [N/A]

Product key Type your 25-character product key for
SMART Notebooksoftware.

You can type the product keywith or without
hyphens.

When you type a volume product key, the software
activates when you deploy it to your network
computers.

SMART response 2 SMART response 2 software is now
included in the installation and replaces
SMARTResponse.

IMPORTANT

Please review the details of the SMART response
2update to ensure it will not disrupt current teach
work flows. Existing data may need to be backed
up. Learn more (
https://education.smarttech.com/en/products/sm
art-learning-suite/smart-response-2/smart-
response-2-faqs).

Delay activation Select to register the product keys on a
system without activating them.Registered
keys can be activatedwhen users start
SMART Notebooksoftware.

If you don’t select this setting, the software
automatically activates during installation
rather than manually after installation.

Delaying activation is useful for uniform deployments
that include users who don’t use SMART Notebook
software.Only users who start SMART Notebook
software activate registered keys and consume a
license.

http://www.smarttech.com/kb/171151
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Control Procedure Notes

Disable the License
Status dialog box

Select to prevent the software activation
reminder from appearing after
SMART Notebooksoftware starts.

When this checkbox is selected, the software
activation reminder appears onlywhen the
SMART Notebooksoftware trial period expires.

General Options: Installation Options

Start SMART System
Menu at logon

Select to start the SMART System Menu
when the user logs on.

[N/A]

SMART Technologies
Error Report

SMART Technologies Error Report installs
by default as part of the installation.

This application installs by default as part of the
installation, but can be turned off through Install
Manager.

General Options: Network/Firewall Settings

SMART lab features
operates as expected

Add the URLs to your teacher and student
network’s whitelist.

This setting confirms that the SMART lab features
operate correctly in SMARTNotebook.

Handwriting recognition: Language selection

Handwriting
recognition: Language
selection

English is selected by default. You can also
select Czech,Danish,German,Hungarian,
Spanish, Finnish, French, Italian,
Norwegian,Dutch, Polish, Portuguese,
Russian, Swedish, andChinese (Simplified)
in addition to English.

[N/A]

General Options: SMART Product Update

Install SMART Product
Update in Fullmode

Select to install SMART Product Update
(SPU) in Fullmode.

[N/A]

Install SMART Product
Update in Dashboard
mode

Select to install SPU in Dashboardmode. [N/A]

Do not install SMART
Product Update

Select to not install SPU. [N/A]

Check for updates Type the number of days (1 to 60) between
SPUchecks.

This option is available only if you install SPU in Full
mode.

By default, SPUchecks for product updates every 30
days.

Notify users about
SMART product
updates

Select to notify users of available SMART
product updates.

This option is available only if you install SPU in Full
mode.

Reset per-user
changes to the
previous two settings

Select to remove existingCheck for
updates andNotify users about SMART
product updates values the next time the
user runs SPU.

This enables administrators to push new values for
these settings to computers and ensures the new
values are accepted. Individual users can stillmodify
these settings.

General Options: Customer Experience

Enable the Customer
Experience Program
on all devices

Select to automatically enable the
Customer Experience Program for all
users.

[N/A]

http://www.smarttech.com/kb/171151
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Control Procedure Notes

Disable the Customer
Experience Program
on all devices

Select to automatically disable the
Customer Experience Program for all
users.

[N/A]

SMART Notebook: Gallery Content

See Installing and
maintainingGallery
content on page 27

[N/A] [N/A]

SMART Product Drivers: Optional Settings

Start SNMPAgent
services at logon

Select to enable SNMPAgent services. [N/A]

SMART Ink: Optional Settings

Start SMART Inkat
logon

Select to start SMART Inkwhen the user
logs on.

[N/A]

Updating SMART Learning Suite 17.1
SMART periodically releases updates to its software. These updates add new features and resolve

issues.

Go to smarttech.com/software to download the latest updates.

To update software

1. Download the DMG file from the website.

2. In Finder, browse to and double-click Applications/SMART Technologies/

Install Manager.

The SMART Install Manager window appears.

3. Open the DMG file you downloaded (see Chapter 2: Customizing the software on page 5).

4. Customize the file by setting the controls on each page.

OR

Apply customizations that you previously created for an earlier version and saved in an XML

file by selecting File > Import, browsing to the XML file, and then clicking Open.

5. Publish your customizations as a PKG file, and then deploy the PKG file to computers on your

network.

http://www.smarttech.com/kb/171151
http://www.smarttech.com/software


CHAPTER2
CUSTOMIZING THE SOFTWARE

9 smarttech.com/kb/171151

Removing SMART Install Manager
You can remove SMART Install Manager from your computer if you no longer need it. You can do

this using SMART Uninstaller or Terminal.

To remove SMART Install Manager using SMART Uninstaller

1. In Finder, browse to Applications/SMART Technologies, and then double-click

SMART Uninstaller.

The SMART Uninstaller window opens.

2. Select Install Manager, and then click Remove.

A dialog box appears, prompting you to confirm the removal.

3. Click OK.

4. Type your administrator password, and then click OK.

To remove SMART Install Manager using Terminal

1. In Finder, browse to Applications/Utilities, and then double-click Terminal.

The Terminal window opens.

2. Type the following command:

sudo "/Applications/SMART Technologies/SMART Uninstaller.app/
Contents/Library/LaunchServices/com.smarttech.uninstallHelper" -i
com.smarttech.instllmgr10

3. Click RETURN.

4. Type your administrator password, and then click RETURN.

http://www.smarttech.com/kb/171151
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Chapter 3: Deploying the software

After you customize the software with SMART Install Manager, you can deploy PKG files to the

computers on your network.

NOTE

You might need to manually activate the software after you deploy it.

There are many methods for deploying software installation packages. The following are two

common methods:

l Use Apple Remote Desktop software to manage your software installations.

l Use Terminal to install customized software on each computer.

NOTE

For more information on using Apple Remote Desktop software, refer to the documentation you

received with the software.

To deploy SMART software using Apple Remote Desktop software

1. Copy the PKG file that you created with SMART Install Manager to a server that is accessible

to all the computers you want to install the software on.

2. Using Apple Remote Desktop software on the server, select the computers that you want to

update.

3. Select Install Packages.

A dialog box appears.

4. Drag the PKG file to the Packages box in the dialog box.

5. Click Install.

The software installs on the selected computers.

http://www.smarttech.com/kb/171151
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To deploy SMART software using Terminal

1. In Finder, browse to Applications/Utilities, and then double-click Terminal.

The Terminal window appears.

2. Type the following command:

sudo installer -target / -pkg "[Path]/[File name].pkg"

Where

o [Path] is the path to the PKG file.

o [File name] is the name of the PKG file.

NOTE

A custom PKG file created with SMART Install Manager is only compatible with the installer

command line, or with tools such as Apple Remote Desktop.

3. Click RETURN.

4. Type your administrator password, and then click RETURN.

http://www.smarttech.com/kb/171151
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Chapter 4: Activating and renewing the
software

Activating the software during installation 13
Activating the software after installation 13
Renewing keys 15

Renewing keys in unattended mode 15
Renewing keys in user interface mode 16
Enabling and disabling automatic renewal of keys 17

Using SMART Product Update (SPU) to retrieve activation status 18
Returning a product key activation with a command-line script 19

Activating the software during installation
If you want to activate SMART Notebook software during deployment, you can use either of the

following practices, depending on your deployment method:

l System imaging: If you use system imaging, do not activate the software before you freeze

the image. You can use the Delayed Activation feature to register your product key on the

system before freezing it. After the image is deployed, SMART Notebook software, will

prompt you to activate the registered product key. (see Delay Activation procedure in the

table under SMART Install Manager controls on page 6).

l Network deployment: If you use a network deployment tool such as Apple Remote Desktop,

you can specify your product key normally in Install Manager or by using command-line

parameters. Activation will occur during installation on each individual computer.

Activating the software after installation
There are two situations in which the software doesn’t activate completely:

l Imaging a computer: Activation is linked to the hardware identifier of the computer on which

the software is installed and activated. If you clone a hard drive image with installed and

http://www.smarttech.com/kb/171151
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activated software, you must activate the software on each cloned computer.

l Reverting a computer to an earlier state: If you use system recovery or protection software

that periodically restores the computer to an earlier state, you might need to activate the

software before locking the computer so that the activation record is not cleared each time

the computer is restored.

Run the activation wizard while the computer is connected to the network, or complete the

following procedure to activate the software on each computer.

NOTE

SMART Product Drivers and SMART Ink don't require activation.

Flag Purpose

--a Activate the product key automatically.
Specify if it’s an auto renew or not:

--no-auto-renew

or

--auto-renew

--pks="[Product keys]" Specify the product keys. When there are one or more
product keys use commas to separate.

--pk Specify the product key.

--v=4 Activation version for this release.

--puid <Product ID> Specify the Product ID, where Product ID is notebook_14

--monitor=[Number] Specify the monitor to display the activation wizard.

--proxy=[Host:Port] Specify the proxy host and port number to use for
activation.

--proxyuser=[User] Specify the proxy user name to use for activation.

--proxypassword=[Password] Specify the proxy password to use for activation.

--locale=[Code] Display the activation wizard user interface in a specific
language, where [Code] is your language code.

To activate SMART software after installation

1. In Finder, browse to /Applications/Utilities, and then double-click Terminal.

The Terminal window appears.

http://www.smarttech.com/kb/171151
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2. Type the following command:

/Library/Application\ Support/SMART\ Technologies/
Activation\ Wizard.app/Contents/MacOS/Activation\ Wizard
--puid notebook_14 --uipack notebook_10 --m=4 --v=4 --pks
"[Product keys]" --a <RENEW_OPTION>

o [Optional flags] are optional flags you can include to configure the activation wizard.

o Where [Product keys] are one or more software product keys separated by commas.

o Where <RENEW_OPTION> is --no-auto-renew or --auto-renew.

3. Click RETURN.

4. Type your administrator password, and then click RETURN.

Renewing keys
If your school has purchased maintenance or subscription licenses, SMART software attempts to

renew the keys automatically on a scheduled basis before and after the keys’ expiry dates.

However, you can choose to explicitly renew the keys at a specified time. You can also choose to

disable automatic renewal in situations where you don’t want the keys on a computer to be

renewed (because, for example, you’re planning to retire the computer).

TIP

The activation wizard user interface distinguishes between maintenance and subscription

licenses:

l Maintenance licenses are labeled with “Premium features will expire on [Date] without an

active subscription”.

l Subscription licenses are labeled with “Expires on [Date]”.

Renewing keys in unattended mode

To renew all keys

Run the following command:

/Library/Application\ Support/SMART\ Technologies/

http://www.smarttech.com/kb/171151
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Activation\ Wizard.app/Contents/MacOS/Activation\ Wizard --m=15 --v=4
--renewal-mode all

To renew all keys associated with a single product

Run the following command:

/Library/Application\ Support/SMART\ Technologies/
Activation\ Wizard.app/Contents/MacOS/Activation\ Wizard --m=15 --v=4
--renewal-mode product --puid=[Product]

Where [Product] is notebook_14.

NOTE

This command renews all keys associated with the specified product.

To renew specific keys

Run the following command:

/Library/Application\ Support/SMART\ Technologies/
Activation\ Wizard.app/Contents/MacOS/Activation\ Wizard --m=15 --v=4
--renewal-mode product --puid=[Product] --pks="[Product keys]"

Where

o [Product] is notebook_14.

o Where [Product keys] are one or more software product keys separated by commas.

Renewing keys in user interface mode

To renew all keys associated with a single product

Run the following command:

/Library/Application\ Support/SMART\ Technologies/
Activation\ Wizard.app/Contents/MacOS/Activation\ Wizard --m=16 --v=4
--renewal-mode product --puid=[Product] --uipack=[UI pack]

http://www.smarttech.com/kb/171151


CHAPTER4
ACTIVATING AND RENEWING THE SOFTWARE

17 smarttech.com/kb/171151

Where

o [Product] is notebook_14.

o [UI pack] is the corresponding UI pack for the selected product (notebook_10).

NOTE

This command renews all keys associated with the specified product.

To renew specific keys

Run the following command:

/Library/Application\ Support/SMART\ Technologies/
Activation\ Wizard.app/Contents/MacOS/Activation\ Wizard --m=16 --v=4
--renewal-mode product --puid=[Product] --uipack=[UI pack] --pks="[Product
keys]"

Where

o [Product] is notebook_14.

o [UI pack] is the corresponding UI pack for the selected product (notebook_10).

o Where [Product keys] are one or more software product keys separated by commas.

Enabling and disabling automatic renewal of keys

To enable automatic renewal of specific keys

Run the following command:

/Library/Application\ Support/SMART\ Technologies/
Activation\ Wizard.app/Contents/MacOS/Activation\ Wizard --m=17
--puid=[Product] --v=4 --auto-renew --pks="[Product keys]"

Where

o [Product] is notebook_14.

o Where [Product key] is the software product key.

http://www.smarttech.com/kb/171151
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To disable automatic renewal of specific keys

Run the following command:

/Library/Application\ Support/SMART\ Technologies/
Activation\ Wizard.app/Contents/MacOS/Activation\ Wizard --m=17
--puid=[Product] --v=4 --no-auto-renew --pks="[Product keys]"

Where

o [Product] is notebook_14.

o Where [Product keys] are one or more software product keys separated by commas.

To disable automatic renewal on a computer

Run the following command:

/Library/Application\ Support/SMART\ Technologies/
Activation\ Wizard.app/Contents/MacOS/Activation\ Wizard --m=18 --v=4
--no-auto-renew

To enable automatic renewal on a computer

Run the following command:

/Library/Application\ Support/SMART\ Technologies/
Activation\ Wizard.app/Contents/MacOS/Activation\ Wizard --m=18 --v=4
--auto-renew

Using SMART Product Update (SPU) to retrieve
activation status
You can use SMART Product Update (SPU) from the command line to retrieve information on SPU

settings and activation status. You could use this in scripts with industry standard execution tools to

retrieve information on your network’s computers.

http://www.smarttech.com/kb/171151
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To use SPU to retrieve activation status

Run the following command:

"/Application/SMART Technologies/SMART Tools/SMART Product
Update.app/Contents/MacOS/SMART Product Update" --query [Options] >
OutputFile.txt 2> /dev/null

NOTES

o OutputFile.txt is the file in which you record the results. The path to this file can be

absolute or relative. When specifying a path to a folder, make sure you have write

permissions to that folder.

o The 2> /dev/null command suppresses any messages that appear on the Standard

Error output stream.

o [Options] is used for the following optional parameters:

o --format [Format]

Valid values for [Format] are csv, json or xml. The json and xml format provides full

details, and csv formats provide basic information.

o --key [Key]

This parameter is used to narrow down the returned results. The appropriate

format for this parameter is json or xml.

Returning a product key activation with a
command-line script
As of version 17.0, SMART Notebook supports the return of a product key activation with a

command-line script. An Activation Wizard.app command can be deployed across the network to

return the activation from several computers, making the product key available for use on other

computers.

You can specify multiple keys in one command by using the command format below.

http://www.smarttech.com/kb/171151
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To return product keys

Run the following command:

/Library/Application\ Support/SMART\ Technologies/Activation\
Wizard.app/Contents/MacOS/Activation\ Wizard --puid notebook_16 --m=4 --v=4
--return --pks=[Product key],[Product key]

http://www.smarttech.com/kb/171151
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Chapter 5: Uninstalling the software

Using SMART Uninstaller 21
Using Apple Remote Desktop 22
Using Terminal 23

After installing SMART Learning Suite 17.1, you can use SMART Uninstaller, Apple Remote Desktop

or Terminal to uninstall the software.

Using SMART Uninstaller

To uninstall SMART Learning Suite 17.1 using SMART Uninstaller

1. In Finder, browse to Applications/SMART Technologies, and then double-click

SMART Uninstaller.

The SMART Uninstaller window will appear.

http://www.smarttech.com/kb/171151
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2. Select the software you want to uninstall.

NOTES

o Some SMART software is dependent on other SMART software. If you select this

software, SMART Uninstaller automatically selects the software on which it depends.

o SMART Uninstaller automatically uninstalls any supporting software that is no longer

being used. If you choose to uninstall all SMART software, SMART Uninstaller

automatically uninstalls all supporting software, including itself.

o To remove the previous SMART Install Manager, use SMART Uninstaller found in the

Application/SMART Technologies folder.

o The latest SMART Install Manager icon will appear under the Applications folder, and

can only be uninstalled by dragging to the Trash can.

TIPS

o To select more than one software application, hold down SHIFT or COMMAND while

selecting the software applications.

o To select all software applications, click Select All.

3. Click Remove, and then click OK.

4. If prompted, enter a user name and password with administrator privileges, and then click OK.

SMART Uninstaller uninstalls the selected software.

5. Close SMART Uninstaller when done.

Using Apple Remote Desktop

NOTE

For general information on using Apple Remote Desktop, refer to the documentation you

received with the software.

To uninstall SMART Learning Suite 17.1 using Apple Remote Desktop

1. Using Apple Remote Desktop on the server, select the computers that you want to update.

2. Press UNIX.

A dialog box appears.
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3. If you want to uninstall all SMART software, type the following command:

"/Applications/SMART Technologies/SMART Uninstaller.app/
Contents/Resources/uninstall" --all

NOTE

This command uninstalls all SMART software from 2012 or later.

OR

If you want to uninstall select SMART software, type one of the following commands:

o SMART Notebook software

"/Applications/SMART Technologies/SMART Uninstaller.app/
Contents/Resources/uninstall" -i com.smarttech.notebook10

o SMART Product Drivers

"/Applications/SMART Technologies/SMART Uninstaller.app/
Contents/Resources/uninstall"
-i com.smarttech.boardDrivers.pkg

4. Under Run command as, press User, and then specify the root user.

5. Press Send to uninstall the software from your network computers.

Using Terminal

To uninstall all SMART software using Terminal

1. In Finder, browse to Applications/Utilities, and then double-click Terminal.

The Terminal window opens.

2. Type the following command:

sudo "/Applications/SMART Technologies/SMART Uninstaller.app/
Contents/Resources/uninstall" --all

3. Press RETURN.
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4. Type your administrator password, and then press RETURN.

NOTE

This command uninstalls all SMART software from 2012 or later.

To uninstall select SMART software using Terminal

1. In Finder, browse to Applications/Utilities, and then double-click Terminal.

The Terminal window opens.

2. Type the following command:

sudo "/Applications/SMART Technologies/SMART Uninstaller.app/
Contents/Resources/uninstall" --list

3. Press RETURN.

A list of available package IDs appears.

4. Type the following command:

sudo "/Applications/SMART Technologies/SMART Uninstaller.app/
Contents/Resources/uninstall" -i [Package ID]

Where [Package ID] is the ID of the package you want to uninstall.

NOTE

You can type multiple instances of -i [Package ID] to uninstall multiple packages in the

same command. For example:

sudo "/Applications/SMART Technologies/SMART Uninstaller.app/
Contents/Resources/uninstall" -i com.smarttech.notebook10
-i com.smarttech.boardDrivers.pkg

5. Press RETURN.

6. Type your administrator password, and then press RETURN.
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Appendix A: Languages

The following are the languages supported by all products in the SMART Learning Suite:

l English (U.S.)

l English (UK)

l Czech

l Chinese (Simplified)

l Danish

l Dutch

l Finnish

l French

l German

l Italian

l Hungarian

l Norwegian

l Polish

l Portuguese (Brazil)

l Russian

l Spanish

l Swedish
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Installing and maintaining Gallery
content

Gallery content includes the following:

l Lesson Activity Toolkit, which contains objects teachers can use to create their own lesson

activities.

You can access Gallery content from the Gallery tab in SMART Notebook software.

Configuring Gallery content using SMART Install
Manager
Complete the procedure in this section to configure Gallery content.

To configure Gallery content using SMART Install Manager

1. Open the software installation package in SMART Install Manager.

2. Click Product Selection.

The Product Selection page appears.

3. Select SMART Notebook (and any other products you want to install).

4. Click Gallery Content.

The Gallery Content page appears.

5. Select the Gallery content to be installed on each computer

Gallery Essentials

Lesson Activity Toolkit

6. Publish your changes as a PKG file, and then deploy the PKG file.

Working Gallery content locations
After installing the software, you can do the following:
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l Starting the software in Administration mode.

l Change the location of the My Content folder.

l Create or connect to a Team Content folder.

l Connect to an RSS feed.

Starting the software Administration mode
Before you can maintain content folders, you must start the software in Administration mode.

To start SMART Notebook software in Administration mode

1. In Finder, browse to /Applications/Utilities, and then double-click Terminal.

The Terminal window appears.

2. Type the following command:

sudo /Applications/SMART\ Notebook/Notebook.app/Contents/ MacOS/Notebook -
admin

3. Click RETURN.

4. Type your administrator password, and then click RETURN.

SMART Notebook software starts in Administration mode.

Changing the location of the My Content folder
The My Content folder is a location where teachers and students can store content for their

individual use.

You can specify the location of the My Content folder during installation. If you don’t specify a

location, the default location is /Library/Application Support/SMART Technologies Inc/Gallery/My

Content.

To change the location of theMy Content folder after installation

1. Start the software in Administration mode.

2. Click the Gallery tab.

3. Click the Click here for more Gallery options icon, and then select Administration: Content

Locations.

The Administration: Content Locations dialog box appears.
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4. Click Browse.

The Open dialog box appears.

5. Browse to and select the new My Content folder, and then click OK.

6. Click Close.

7. Close the software.

Creating or connecting to Team Content folders
All users can create new content and save it in theirMy Content folders. To allow users to share

content, you must create or connect to a Team Content folder.

TIP

If you create a Team Content folder on a computer’s hard disk, the folder is available only to

users of that computer. However, if you create a Team Content folder on a server, the folder is

available to all users on the school’s network with read and write access to the folder.

To create a new Team Content folder

1. Start the software in Administration mode.

2. Click the Gallery tab.

3. Click the Click here for more Gallery options icon, and then select Administration: Content

Locations.

The Administration: Content Locations dialog box appears.

4. Click Create New.

The Open dialog box appears.

5. Browse to and select the folder you want to designate as a Team Content folder, and then

click Open.

6. Click Close.

7. Close the software.

To connect to an existing Team Content folder

1. Start the software in Administration mode.

2. Click the Gallery tab.
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3. Click the Click here for more Gallery options icon , and then select Administration: Content

Locations.

The Administration: Content Locations dialog box appears.

4. Click the + button.

The Open dialog box appears.

5. Browse to and select the Team Content folder, and then click Open.

6. Click Close.

7. Close the software.

To disconnect a Team Content folder

1. Start the software in Administration mode.
2. Click the Gallery tab.

3. Click the Click here for more Gallery options icon, and then select Administration:Content

Locations.

The Administration: Content Locations dialog box appears.

4. Select the folder in the Team Content list, and then click the – button.

IMPORTANT

If you installed the Gallery Essentials and Lesson Activity Toolkit collections, folders for

those collections appear in the Team Content list. Do not remove these folders from the list,

or users will not be able to access these collections.

5. Click Close.

6. Close the software.

Connecting to an RSS feed
You can connect to a public or private RSS feed to send information to your school’s SMART

Notebook software and SMART Notebook SE users through the Gallery tab.

RSS is a format for delivering regularly changing web content. Many news-related websites, blogs

and other publishers broadcast their content as RSS feeds.

To connect to an RSS feed

1. Start the software in Administration mode.

2. Click the Gallery tab.
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3. Click the Click here for more Gallery options icon , and then select Administration: Content

Locations.

The Administration: Content Locations dialog box appears.

4. Type the URL of the RSS feed in the Online Resources box.

5. Click Close.

6. Close the software.
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